Color Management Software

Calibration
Sensor Used

Dedicated Color Management Software for ColorEdge

Advanced

Photo Printing Instructions

This booklet introduces the procedure on how to enjoy printing photo data at home.
If any of the following applies, please see the user's manual available on the ColorNavigator 7
download site:
- Using ColorNavigator 7 for businesses
- Using ColorNavigator 7 for creating web content, etc.
- Using ColorNavigator 6

www.eizoglobal.com/products/coloredge/cn7/index.html

Calibrating ColorEdge monitor display with
ColorNavigator 7 produces accurate colors.

Without Calibration
Created with Uncalibrated Monitor

Color Management Monitor

Color Management Software

+

Printed Material

Retouch

The printed material turns out to be different from what it appeared on the monitor.

Calibration Sensor (sold separately)

Even after careful retouching processes, the
printed material will not turn out as expected.

The colors of the printed material will not turn out as
expected, leading to many reprints and wasted time.

Calibrated ColorEdge
Created with Calibrated ColorEdge
Images captured as photos

Photo data displayed on monitor

Printed photo images

By calibrating the monitor and configuring the retouching software and the printer
correctly, colors are adjusted between data displayed on the monitor and photo images to
be printed. (Color Matching)
With correct color matching, captured photos can be displayed exactly as you imagined.
Precise retouching using spot-on colors is also possible. Enjoy making creative content
exactly the way you want it to be!

What is Calibration?

What is a Calibration Sensor?

Calibration is a process of adjusting
the display by referencing values
measured by the sensor so that the
device is configured to produce the
target display results.

It is a measurement device used for measuring the current display status so
that the monitor display can be adjusted in reference to the target values.

External Sensor (sold separately)
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Built-in Calibration Sensor (CG Series)

Printed Material

Retouch

The printed image matches the screen, increasing productivity and quality!

More Advantages of Using ColorNavigator 7

Consistent

ColorNavigator allows you to set target values for adjustments in each color mode. The target values configured
on ColorNavigator are saved in respective color modes of the monitor. Using the mode switching button on the
front side of the monitor, the display can be easily switched to the corresponding target level without starting
the software on the computer.
2

How the Color Matching Works

Prepare a Calibration Sensor.

The purchased monitor in the initial state is not configured to the display optimized for photo printing. Before you begin,
the monitor needs to be calibrated to a state that is most suitable for photo printing.
To make your work turn out the way you expect it to be, it is important to perform the optimum “Color Matching”, including
the environment setup for test page printing, as well as the monitor, retouching software, and printer settings. The
sections from here on will introduce the color matching procedure.

The measurement device (calibration sensor) is required for calibration.
Prepare a measurement device if you do not have one on hand.
(For the CG Series products, calibration can be performed by the built-in
calibration sensor.)

Calibration Sensor EX4

1

Connecting Monitor and
Computer

2

Installing ColorNavigator

3

Download the software and install it.

Check to see if they are connected properly.

Optimize the display setting for the printed
image so that the images are displayed in
correct colors.

See page 5 for details.

5

Configuring Printer
Print a test page in the correct setting.

See page 17 to page 20 for details.
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Monitor Adjustment
(Calibration)

See page 9 to page 14 for details.

See page 6 to page 8 for details.

6

Environment Setup
Check a test print page under adequate
ambient light.

See page 21 to page 22 for details.

7

4

Configuring Image
Retouching Software
Import photo data into your computer, display
it in the correct settings, and select a photo
image to be printed.

See page 15 to page 16 for details.

Checking Photo Prints

Color Matching Complete!

Compare a test print against the monitor
image to see if the colors match.
Fine-tune the monitor as needed.

Trust the screen display. Retouch and print.
Enjoy creating your own material!

See page 23 to page 24 for details.
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1. Connect the Monitor to a Computer

2. Download ColorNavigator 7

To be able to perform the monitor calibration smoothly, make sure that the monitor is connected to your computer properly.

1 Access the download site
You will be redirected to the download site from the
ColorNavigator 7 dedicated website.

1 Video Signal Cable

www.eizoglobal.com/products/coloredge/cn7/index.html

2 USB Cable
Be careful with the
direction to insert!

3

Rear Panel of ColorEdge

3
Rear / Side Panel
of Computer

The layout varies by model.

2 Select software
Choose

(Windows) or

(macOS) according

to your computer platform.

1 Connect a video signal cable
Connect the ColorEdge monitor to the video signal output terminal on your computer.

2 Connect a USB cable
Make sure that the shape of the USB terminal matches, and connect the ColorEdge monitor and your computer with a
USB cable.

Monitor with a USB Type-C Connector
By connecting a USB Type-C cable to a computer equipped with the USB Type-C connector that can output video
signals, both video and USB signals are transmitted through the single cable. For details on how to connect them,
see the setup guide for the monitor.
USB Type-C Cable

USB Type-C

USB Type-C
Thunderbolt 3

3 Download software
Read the terms and conditions of the End User
License Agreement, and select the 1 check box for
“I agree to the above license terms.” located at the
bottom of the screen. Then, select 2

3 Connect to the power source

or

(Windows)

(macOS).

Connect the power cable for your monitor and computer, respectively. Turn the power on and verify if the screen image
appears.
For Windows, click “Run” to start the installation.
For macOS, the download of the installer launch file
(.pkg) starts.

Turning Video Mirroring off
If you use the ColorEdge monitor with another monitor, such as when connecting a laptop computer, the video
mirroring function needs to be turned off.

1

2

5

6

2. Install ColorNavigator 7 (for Windows)
4 Run the installation

2. Install ColorNavigator 7 (for macOS)
4 Start the installer

Follow the instructions on the wizard screen. Click “Next” to
proceed with the installation.

Double-click the installer launch file (.pkg) you have saved.

5 Run the installation
Follow the instructions on the installer window. Click “Continue”
to proceed with the installation.

On the license agreement screen, read the terms and
conditions. Then, select the check box for “I accept the
agreement” and click “Next”.
On the acknowledgment screen for the license agreement,
read the terms and conditions. Then, click “Agree”.

On the “Ready to Install” screen, click “Install”.
Confirm the location to install, and click “Install”.

Window Displayed during Installation

Confirm the message of installation completed, and click
“Close”.

During the installation of ColorNavigator 7, the driver for the measurement device is automatically installed.
A confirmation window may appear several times during installation. In that case, click “Install” until the window
disappears.

When installing ColorNavigator 7 on macOS, the confirmation window may appear. Click “OK”.
7
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3. Calibrate the Monitor

For macOS
Use the Finder toolbar and select “Go” > “Applications” to
display the Applications folder.

To match colors between the monitor display and the printed photo images, use a measurement device to perform
calibration.

1 Connect the measurement device
The measurement device is required for performing calibration.
For CS Series, connect the measurement device to the USB port of your computer or monitor. The USB port is located
on the side or rear panel of the monitor.
This connection is not necessary for the CG Series monitors since they have the built-in measurement device (calibration
sensor).

Double-click “ColorNavigator 7.app” in the Applications
folder.

How to Add an Icon to the Dock
Warming up the Monitor
Before you perform calibration on the CS Series monitors, you should wait for at least 30 minutes after turning on the
monitor display so that the on-screen image will be stabilized.

To start ColorNavigator 7 from the Dock after the second time, you
need to add ColorNavigator to the Dock.
While the main window is open, the icon appears on the Dock. With
the main window displayed, right-click the icon shown on the Dock,
and then select “Options” > “Keep in Dock” from the menu.

2 Start ColorNavigator 7
For Windows
Double-click the ColorNavigator icon on Desktop.

Welcome Screen at Initial Startup
During the initial startup, the introduction screen is displayed
and you are prompted to answer simple questions for
setup. Click “Welcome!” in the center of the screen.
Then the main window opens.
After the second time, the main window appears first when
you start the application.
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3 Select target values

4 Select a measurement device and perform calibration

From the menu displayed on the main window, select a color mode and an adjustment target that are optimized for
printing photo images.
As the optimum target values for printing photo images, set
1 Color mode to “CAL” and select 2 “Print Proofing” from
the target combo box.

2

Click 3 “Calibrate”.

By selecting “Calibrate”, the measurement patterns are displayed. Adjustments will be made automatically.
 If you use the built-in calibration sensor, see page 13.

CS Series (Using Measurement Device)
In the list of measurement devices, select a name
of the measurement device you have connected.
Then, click .
→ The “Measurement Device Attachment” dialog
appears.

1
3

Main Window
②

Follow the screen instructions and attach the measurement
device. Then, click “Proceed”.

④
(1) Color mode List
(2) Target list
(3) Calibrate button
(4) Help

①

③

Target Values for Adjustments
ColorNavigator offers a variety of adjustment target values that are optimized for the purposes.

Video
Creation
STEP

1

STEP

2

STEP

3
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Web Content
Creation

Digital Content
Creation

Select Color Mode appropriate for the criteria
BT.709, etc.

sRGB

Adobe RGB

Commercial
Printing

Select

CAL

Select appropriate
target preset for
adjustments

Attaching the Measurement Device on the Screen

ColorNavigator 6
Users

To prevent the sensor from sliding and make calibration easier,
tilt the monitor unit until it faces upward.

for Color Mode

Target
migrated from
ColorNavigator 6

Print Proofing

Click the “Calibrate” button to perform adjustments
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CG Series (Using Built-in Calibration Sensor)

Why Periodic Calibration is Needed

In the list of measurement devices, select “Built-in Sensor”.
Then, click

.
With continued use, monitors lose the ability to display colors correctly, causing them to become darker (decreased
brightness) or change in hue (white point deviation).
To restore the monitor to its original state, it is necessary to readjust the monitor through regular calibration.

Restore

Do this every 200 hours!

Click “Proceed”.

Correct Display

Changes with Use Over Time

Recalibrating the Monitor

With ColorNavigator 7 and ColorEdge, you can easily recalibrate the monitor for
reliable results.

5 Finish the calibration
Once the calibration is complete, the “Finish” screen appears.
Click “Finish”.

To maintain the
reliable display state,
don’t forget to calibrate
the monitor periodically!
For details, see
“Calibrate the
Monitor Periodically”
on page 25.

Color Mode Status Display
When the main window opens again after the calibration is complete, the
left band color for the calibrated color mode turns to blue. The band color
varies by the color mode status.
Gray: Not calibrated
Blue: Calibration completed
Pink:	Long time has passed since the last calibration,
and re-calibration is required

13
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4. Configure the Image Retouching Software
To match the colors between your monitor and photo prints, it is important for your image retouching software to have the
appropriate settings in addition to the monitor having the most optimum adjustments.
Configure the color settings correctly for the image retouching software that supports color matching. By using the correctly
configured retouching software and opening an image on it, the image can be displayed in the properly adjusted colors.

Canon Digital Photo Professional (for Windows)
In the “Tools” pull-down menu, select
“Preferences” and then 1 “Color
management”. For 2 “Default settings
of Work color space”, “sRGB” or
“Adobe®RGB” is selected according to
your color management method, and
3 “Use the OS settings” is selected
at “For display” under “Color matching
settings”.

2
1

3

Types of Image Retouching Software
Keep the initial settings! No adjustment
needed

The image retouching software compatible with color
matching is available in two types: software that automatically
references the monitor profile configured on the computer’s
operating system and software that requires manual settings.
The former can be used in the initial settings, but the latter
needs adjustments so that images can be displayed correctly
by referencing the monitor profile.

Adobe® Photoshop®
Adobe® Photoshop® Lightroom® Classic
Canon Digital Photo Professional, etc.

For details visit the EIZO website.

www.eizoglobal.com/library/management/matching/retouch_software/step3.html

Canon Digital Photo Professional (for macOS)
2
1

Image Retouching Software Used in the Initial Settings
This section introduces the major software that automatically references the monitor profile configured on the computer’s
operating system and does not require adjustment from the initial settings. The initial settings are also shown.
Using this software, images can be displayed correctly without having to change the settings manually.

In the pull-down menu of “Canon Digital
Photo Professional”, select “Preferences”
and 1 “Color management”. For 2
“Default settings of Work color space”,
“sRGB” is selected according to your
color management method.

Adobe® Photoshop
1

2

1 “Europe General Purpose 3” is selected in the Settings

Click “Edit” - “Color Settings”.
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field and 2 “Preserve Embedded Profile” is selected in
Color Management Policies.
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EPSON Printers

5. Configure the Printer
To be able to print retouched photo data accurately, it is important to configure the color matching settings on your printer.
Open a photo image used for color matching on the retouching software and configure your printer.

Printer Settings
The configuration procedure described here uses the following setup as an example.
■ OS: Windows 10 ■ Printer: EPSON SC-PX5V II/Canon PIXUS PRO-10S
■ Paper: EPSON EPSON Photo Paper <Glossy>/Canon Glossy Pro Platinum Grade
■ Image retouching software: Adobe Photoshop CC
For details on the printer settings using the other image retouching software or using it on a macOS, visit the EIZO
website.

www.eizoglobal.com/library/management/matching/printer/step4.html

EIZO also offers print samples you can use for test printing. For details, please visit the EIZO website.

This section introduces how to set up the printer driver for EPSON SC-PX5V II.
For Canon PIXUS PRO-10S, see “Canon Printers” on page 19.

4 Configure the EPSON printer driver (1/3)
The Properties window for the printer opens. Select the
1 “Main” tab and go to 2 “Media Type” and select paper type
you will use. Since the images are printed according to the
color management settings on Photoshop, set 3 “Mode:” on
the printer to “Off (No Color Adjustment)” and select a paper
size to print in the 4 “Size” field. Then, click “OK”.

1
2

3
4

www.eizoglobal.com/library/management/matching/result/
ColorNavigatorElements_sample_chart2_sRGB.jpg

1 Customize proof setup on retouching software (1/3)
In the “View” pull-down menu of Adobe Photoshop, select
“Proof Setup” - “Custom...”.

5 Configure the EPSON printer driver (2/3)

1

2 Customize proof setup on retouching software (2/3)
Once the “Customize Proof Condition” window for
Print Setup appears, go to 1 “Device to Simulate”
and select a profile for paper* you will use. For
2 “Rendering Intent”, select “Relative Colorimetric”. Uncheck
3 “Black Point Compensation” and check 4 “Preview”. Then,
click the “OK” button.

1
2
3

4

2
3
4

Open the Printer Setup window again, and configure the
“Color Management” setting.
For 1 “Color Handling”, select “Photoshop Manages Colors”.
For 2 “Printer Profile”, select a profile for paper* you will use
in the pull-down list. Finally, go to 3 “Rendering Intent” and
select “Relative Colorimetric”, which is the recommended
settings for EIZO products. Then, check 4 “Black Point
Compensation”.
* Profile used for printing EPSON Photo Paper <Glossy> on SCPX5VII “SC-PX5V2 Photo Paper(G)”

* Profile used for printing Glossy Pro Platinum Grade paper on PRO10S “Canon PRO-10S <PT> 1/2/3 Photo Paper Pro Platinum”
* Profile used for printing EPSON Photo Paper <Glossy> on SCPX5VII “SC-PX5V2 Photo Paper(G)”

3 Customize proof setup on retouching software (3/3)

6 Configure the EPSON printer driver (3/3)
In the “Positions and Size” field, select an area to print and
specify the size, then click the “Print” button.

In the “File” pull-down menu, select “Print”. When the Printer
Setup window opens, configure the “Printer Setup” on the
right. For the 1 “Printer:” field, select “EPSON SC-PX5V2”
or “Canon PIXUS PRO-10 Series”. After selecting the
2 Vertical or Horizontal icon in the “Layout:” field, click
3 “Print Settings”.

1
2
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Canon Printers

7 Configure the Canon printer driver (4/6)
When the Properties window for the printer opens again, click
the “OK” button.

This section introduces how to set up the printer driver for Canon PIXUS PRO-10S.
For EPSON SC-PX5V II, see “EPSON Printers” on page 18.

4 Configure the Canon printer driver (1/6)
The Properties window for the printer opens. Select the
1 “Quick Setup” tab. For 2 “Media Type:”, select a paper
type to use (e.g. Glossy Pro Platinum Grade). For 3 “Printer
Paper Size:”, select a size of paper used for printing.

1

2

3

8 Configure the Canon printer driver (5/6)

5 Configure the Canon printer driver (2/6)
Next, select the 1 “Main” tab. Select 2 “Manual” for “Color/
Intensity”, and then click the 3 “Set” button.

1

1
2
3

2

3

Open the Printer Setup window again, and configure the
“Color Management” setting.
For 1 “Color Handling”, select “Photoshop Manages Colors”.
For 2 “Printer Profile”, select a profile for paper* you will use
in the pull-down list. Finally, go to 3 “Rendering Intent” and
select “Relative Colorimetric”, which is the recommended
settings for EIZO products.
* Profile used for printing Glossy Pro Platinum Grade paper on PRO10S “Canon PRO-10S <PT> 1/2/3 Photo Paper Pro Platinum”

9 Configure the Canon printer driver (6/6)
In the “Positions and Size” field, select an area to print and
specify the size, then click the “Print” button.

6 Configure the Canon printer driver (3/6)
When the Manual Color Adjustment window appears, select
the 1 “Matching” tab. Since the images are printed according
to the color management settings on Photoshop, set
2 “None” for color correction on the printer side. Then, click
the 3 “OK” button.

1
2

3
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6. Check the Printed Images in Adequate Environment
The printed photos appear differently depending on the ambient light. To be able to check the colors appropriately, it
is necessary to control the ambient light by preparing the lighting that is appropriate for evaluating images under the
consistent conditions.

Ambient Light

Ideal Indoor Lighting
5000K High-Color Rendering Room Lighting Recommended

EIZO-Recommended Accessories for Preparing Ideal Environment

If color matching has been successfully performed between on-screen and printed photos under indoor
lighting conditions in the evening, why do they look different under the outside daylight?

Easy-to-Install Light-Shielding Hood with No Assembly Required
This is an EIZO-original light-shielding hood designed to block sunlight and screen reflections effectively. Non-reflective
finish inside the hood prevents glare from the screen as well.

Printed photos reflect the light around them (ambient light), and
the reflected light enters human eyes where they are recognized
as images. On the other hand, the monitors themselves emit the
light, instead of reflecting the ambient light.
Therefore, even if the ambient lighting changes, colors on the
monitors themselves barely change. The printout colors (reflected
light) do not appear in the same way because the ambient light
colors are different under the outside daylight and the nighttime
indoor lighting.

For details on the supported models,
please visit the EIZO website.

Preparing the Ideal Environment
To match the colors between the on-screen image and the photo prints, it is extremely important to prepare an ideal room
environment where the printouts are evaluated. See the hints below and let’s begin setting up the ideal environment for
evaluating the images under the consistent conditions.
Ideal Environment

Choose
neutral colors

Desk light with 5000K
high-color rendering index

Minimize
the effects of
outside light

If replacing the room light is
difficult, this method is an easy
fix for setting up the
environment for evaluating
photo prints.

for walls and
so on
Light-shielding hood
Using the light-shielding hood effectively
blocks external light, such as the glare
from lighting fixtures, etc.

Choose
achromatic
gray for the
desktop
background
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3 Adjust the white point

7. Checking Photo Prints

Adjust the white point by comparing the print image against the monitor display.

Lastly, check the photo print colors. You have now completed the steps up to printing a test page after calibrating the
monitor and configuring the settings for image retouching software and the printer. Let’s compare colors between the
printed photo and the monitor image.

Move the 1 adjustment pointer (
) and change the RGB
value by pressing
/
to adjust the hue until the image
displayed on the monitor looks the closest to the print image.

1

Once you complete the color matching, click 2 “

”.

2

4 Measure the adjustment status
Photo data displayed on monitor

Follow the screen instructions and select the measurement device. Then, measure the adjustment status.
The measurement result window will be displayed once the measurement is complete.

Printed photo images

Click 1 “Finish”. The list now contains this new adjustment
target having the name displayed at 2 “Target name”.

If colors match perfectly, the color matching procedure is complete. If colors are slightly off between the monitor screen
and the photo prints due to environment factors and other causes, you should perform manual adjustments as described
below. The accuracy of color matching can be improved by manually fine-tuning adjusted target values.

1 Adjust the monitor manually
The sections from here on will introduce the procedure to improve the color matching accuracy.
Select 1 “CAL” and click 2
adjustment”.

2

to select “Manual
1

If the Color Matching Is Not Working Well
1

If the color matching with a photo image does not work
as expected, you can also try comparing the print paper
against the white color.

2

2 Adjust the brightness
Adjust the brightness by comparing the print image against the monitor display.
Move the control slider horizontally and adjust the
brightness until the image displayed on the monitor looks
the closest to the print image.
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If the white color matches but the colored parts do not, it is
possible that differences are caused by the printer settings
or attributable to performance issues. Check the display
performance of each printer color.
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CG Series (Using Built-in Calibration Sensor)

Calibrate the Monitor Periodically

Based on the information configured, automatic re-adjustment (Self Calibration) can be executed on a periodic basis.

ColorNavigator 7 makes periodic calibration easy and ensures that it will never be skipped. A set of management functions
helps you remember the timing of readjustment by showing an alert window or changing the color mode band to pink. For
monitors with a built-in sensor, automatic calibration (Self Calibration) can be performed on a periodic basis.

For “Management policy selection”, select “Periodic
calibration” and check “Enable Self Calibration”.
1

1

For “Check period setting”, specify a condition for the
period. In addition to the usage hours, the period can be
specified as a certain number of days using months or weeks.
2

Restore

2

Do this every 200 hours!

3 Click “OK” to complete the settings.

Correct Display

Changes with Use Over Time

Recalibrating the Monitor

3

A reminder for the next periodic calibration is displayed in the
notification field on the main window.

Setting Management Policy for Monitor
Using the monitor’s management function, let’s schedule the periodic calibration.
Click the “Monitor settings” menu and select “Management
Policy”.

After the configured time period has elapsed, a message pops
up.

CS Series (Using Measurement Device)
Based on the information configured, ColorNavigator can notify you of the timing of adjustment.
For “Management policy selection”, select “Periodic
calibration”.

What is the ICC Profile?

1

1

For “Check period setting”, specify a condition for the
period. In addition to the usage hours, the period can be
specified as a certain number of days using months or weeks.
2

2

The ICC profile is a data file that notifies the system of what colors are displayed on the monitor.
Upon completion of the calibration by ColorNavigator 7, an ICC profile is generated, which will be automatically
configured to the computer’s operating system. This profile is extremely important when performing color matching
using image retouching software, a printer and a monitor. To update the ICC profile data periodically, calibration by
ColorNavigator should be performed at least once a year.

3 Click “OK” to complete the settings.

Calibration
120 cd/m2

Print
5000K
Proofing

ICC Profile

3

Unadjusted
ColorEdge
25

Computer

Gamma 2.2

Adjusted
ColorEdge
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■ EIZO and ColorEdge are the registered trademarks of EIZO Corporation in Japan and other countries. ■ ColorNavigator is the trademark of EIZO Corporation. ■Adobe, Lightroom, and Photoshop are the registered
trademarks of Adobe Systems Incorporated in the U.S.A. and other countries. ■ Canon and PIXUS are the registered trademarks of Canon Inc. ■ EPSON is the registered trademark of Seiko Epson Corporation. ■ Mac,
macOS, and OS X are the registered trademarks of U.S. Microsoft Corporation in the U.S.A. and other countries. ■ Windows is the registered trademark of U.S. Microsoft Corporation in the U.S.A. and other countries.

To find out more about our products, visit the EIZO website.
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